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Introduction
Often a defined exposure guidance value, such as reference dose or tolerable daily intake levels, is expressed as an oral exposure in mg/kg body weight/day. However, the chemical being examined may be exposed along a different route of exposure that does not have a defined reference dose. Route-to-route extrapolation is used in these cases to estimate exposure through a different route that still gives the same internal plasma concentration. One approach to these estimations is to parameterize a Physiologically Based Pharmacokinetic (PBPK) model that can simulate both the original and extrapolated route of exposure. The PBPK model is then simulated with the original exposure route to obtain the distribution of plasma concentration for the chemical in question. This distribution is treated as a biomonitoring dataset for running a reverse dosimetry workflow using the same model, but with a different route of exposure. In this case study, we use the PBPK interface to parameterize a trichloroethylene (TCE) PBPK model with an oral route of exposure. We then use the route-to-route extrapolation workflow within PLETHEM to estimate an inhalation exposure that leads to a distribution of arterial blood concentration similar to the oral route. The Route-to Route Extrapolation workflow within PLETHEM uses the Discretized Bayesian Approach (DBA) for estimating a different route of exposure. This approach requires us to create a PBPK model that includes population-level variability.
System Requirements:
Windows 10 with: Edge, Firefox, or Chrome
Mac OS 10.14.x or higher, with: Safari, Firefox, or Chrome
[bookmark: _GoBack]Ubuntu with: Firefox
What this tutorial covers
Route-to-route extrapolation is useful for estimating dose through routes of exposure for which a reference dose has not or cannot be established through traditional toxicological assessment. The underlying assumption is that both the reference dose and the extrapolated dose result in similar internal points of departure for an observed effect. This requires a human PK or PBPK model for a specific compound to describe the relationship of a biomarker of exposure and an external dose along the two routes of exposure involved. 
It is impractical to “reverse” the model description to predict exposure from a distribution of biomarkers in the body. Instead, the approach used in PLETHEM iteratively runs forward dosimetry simulation and uses statistical tools to estimate exposure along a different route of exposure. Some information on the nature of the exposure to be examined is still provided by the user, such as the source, frequency, and duration of exposure. It is also important to consider uncertainty and variability in human exposure and pharmacokinetics. This is the role of the Monte Carlo analysis.
In this case study, we first parametrize a TCE model using the PBPK interface in PLETHEM. This parameterized model is used to generate the two datasets—distribution of an internal biomarker at reference exposure and multiple distributions of the same biomarker across a range of doses along the second route of exposure.
Parameterizing the TCE Model
The rapidPBPK model within PLETHEM was parameterized as a TCE model using chemical-specific values and QSAR models. 
Link To rapidPBPK:
scitovation.com/plethem_live

Create an exposure set
We will create an exposure set for the reference route of exposure using the TCE oral RfD value of 0.0005 mg/kg BW/day from EPA IRIS assessment.[footnoteRef:2] [2:  https://cfpub.epa.gov/ncea/iris2/chemicalLanding.cfm?substance_nmbr=199] 

1) Navigate to the “Model Setup” tab.
2) Navigate to the “Exposure” tab in the user interface.
3) Select “Oral” from the sidebar to show oral exposure inputs.
4) Set the “Daily Oral Dose” to 0.0005 mg/kg BW, “Duration of Exposure per Day (h/day)” to 1h/day, and “Number of Boluses per Day” to 1.
5) Click the “Save As” button to save the exposure set by the name “IRIS Oral RfD.” Click “Add” to save the exposure.
6) Click the “Reset Exposures” button on the left side menu when finished or you will not be able to add additional parameters.
Create the extrapolation exposure set
We will use the route-to-route extrapolation workflow to estimate inhalation exposure to TCE. The workflow will estimate the exposure for a given set of exposure conditions. In the case of inhalation exposure, we must specify the length of inhalation exposure, hours per day, and the number of days of dosing per week. We assign a dummy exposure value of 1 ppm as PLETHEM requires exposure sets to have an exposure value. 
1) Navigate to the “Model Setup” tab.
2) Navigate to the ““Exposure” tab” in the user interface.
3) Click the “Reset Exposures” button to set all exposure values on the UI to 0. PLETHEM can simulate only one active route of exposure at a time. If the exposure values for multiple routes are set, PLETHEM will show an alert and will not allow users to save exposure sets until the error is resolved.
4) Select “Inhalation” from the sidebar to show inhalation exposure related inputs.
5) Set the “Inhalation Exposure” to 1ppm, “Duration of Inhalation Exposure” to 8 h/day, and “Exposure days in a week” to 5.
6) [image: ]Click the “Save As” button to save the exposure set, naming it “Inhalation Exposure Extrapolation Route.” Click “Add” to save the exposure. 

Create a chemical set
[image: ][image: ]PLETHEM uses QSAR models to estimate partition coefficients for distribution of chemicals. The QSAR models use physical-chemical properties of the substance to estimate these values. We used PubChem and the EPA Comptox dashboard to obtain these values for TCE. 

	PubChem Computed Chemical and Physical Properties from Computed Properties

	Property Name
	Property Value
	Reference

	Molecular Weight
	131.38 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	XLogP3
	2.6
	Computed by XLogP3 3.0 (PubChem release 2019.06.18)

	Hydrogen Bond Donor Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Hydrogen Bond Acceptor Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Rotatable Bond Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Exact Mass
	129.914383 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	Monoisotopic Mass
	129.914383 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	Topological Polar Surface Area
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Heavy Atom Count
	5
	Computed by PubChem

	Formal Charge
	0
	Computed by PubChem

	Complexity
	42.9
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Isotope Atom Count
	0
	Computed by PubChem



The values from these data sources are then used to populate the user interface.
1) Navigate to the “Chemical” tab in the user interface.
2) Enter the appropriate input values from PubChem and Comptox Dashboard as show in the figure below.  The value for “Fraction Dissolved in Liquid Phase of Plasma” will be estimated using QSAR models in the next step.
3) Click on the “Estimate Fraction Dissolved” button to estimate fraction of the chemical dissolved in the liquid phase of plasms. 
4) [image: ]Click “Save As” to save the parameter set as “TCE Chemical Parameters.” Click “Add” to save chemical parameters. 

	TCE Chemical Parameters

	Density
	1 g/L

	Molecular Weight
	131.4 g/mol

	Vapor Pressure at 25°C
	9199 Pa

	Log Ko/w in Skin at pH5.5
	1

	Log Ko/w (Octanol:Water Coefficient)
	2.61

	Water Solubility
	1280 mg/L

	Fraction Reabsorbed in Kidney
	0

	Fraction Unbound in Plasma
	0.065



Create a physiological set 
We simulate an adult human male in this case study. To create this standard adult human male physiology description:
1. Navigate to the “Physiological” tab in the user interface.
2. Select “Human” and “Male” under the “Organism” and “Gender” drop-downs respectively. Set “Age” to “25.”
3. Click the “Calculate Physiological Parameters” button to parameterize the model using life-course equations in PLETHEM. The values should match the figure below.
4. [image: ]Click the “Save As” button to save the parameter set. Call the set “Adult Human Male.” Click “Add” to save physiological parameters.

Create an ADME set
In PLETHEM, the ADME set is used to specify parameters related to Absorption, Distribution, Metabolism, and Excretion. While parameters need to be defined for a specific combination of chemical, metabolite, exposure and physiology, we are not tracking the metabolite of TCE in the model. So, our metabolite selection is set to “No Metabolite.”
The “Absorption” and “Excretion” parameters in this case study are left to their default values. Tissue partitioning is calculated by taking the following steps. 
1. Navigate to the “ADME” tab in the user interface.
2. Select the “Distribution” tab.
3. Select the QSAR model to be used for estimating partitioning. “QSAR Model One” refers to the default QSAR model in PLETHEM, which is adapted from the algorithm published by DeJongh et al 1997.[footnoteRef:3] [3:  DeJongh, J., H.J. Verhaar, and J.L. Hermens. A quantitative property-property relationship (QPPR) approach to estimate in vitro  tissue-blood partition coefficients of organic chemicals in rats and humans. Arch Toxicol, 1997. 72(1): p. 17-25.] 

4. Click the “Calculate Partition” button to estimate partition coefficients for all tissues in the model. You can click on the various tissue to see the calculated partition coefficients. The value for fat should match the figure below.
[image: ]TCE metabolism is defined under the metabolism tab. We use the IVIVE algorithm within PLETHEM to scale the intrinsic clearance predicted by the OPERA models (0.00000150366 L/h/10^6 Hepatocytes) to intrinsic clearance in vivo. 
1) [bookmark: _Hlk44259625]Click on “Metabolism” to display metabolism-related inputs.
2) Click the “Perform IVIVE” button to open the IVIVE interface.
3) Under the “Hepatocyte Clearance” tab, enter the value of 1.5e-6 and choose the appropriate units from the “Units” drop-down menu (L/h/10^6 Hepatocytes). 
4) [bookmark: _Hlk44259978]Select “Metabolism Type” to be linear.
5) [bookmark: _Hlk44260012][bookmark: _Hlk44260295][image: ]Click the “Preform IVIVE” button to extrapolate intrinsic clearance in vitro to intrinsic clearance in vivo. You will be returned the Metabolism tab, where the “First Order metabolism in Liver (L/h/kg liver)” value should now be 0.1485.


The entire ADME set is then saved along with the chemicals, physiology, and exposure set it represents.
1) Click the “Save As” button and name the set as “ADME for TCE with Oral Exposure.” Click “Add” to save the set.
Define variability
For this model we are accounting for differences in bodyweight, cardiac output, and respiratory rate between individuals. Variability is defined in PLETHEM as an uncertainty and variability set for parameters in each of the four previously defined sets. This set is saved as a physiological variability set. 
1) Navigate to the “Uncertainty and Variability” tab in the user interface.
2) Select “Physiological” from the side bar.
3) Click on the “New” button to open the variability interface. Let’s call this set “Physiological Variability.”
4) Select “Body weight,” “Cardiac Output,” and “Respiration Rate” from the drop-down menu located under the “Select Parameters to Assign Variability” and click the “Update List” button. 
5) [image: ]Assign “Coefficient of Variation” and “Type of Distribution” parameters as shown in the figure. 

	Import Data, SEEM Data Selections

	Body Weight
	0.3 Log-normal

	Cardiac Output
	0.3 Log-normal

	Respiration Rate
	0.3 Log-normal



6) [image: ]Click “Done” to save the variability set. At this point it is a good idea to save the entire project by selecting the “File” menu and clicking “Save”.

Create a simulation
All the sets can now be put together to create a simulation.
1) Navigate to the “Simulation” tab in the user interface.
2) Click “New” to launch the new “Simulation” dialog.
3) Give the simulation a name “Route to Route Exposure for TCE” and a description “Extrapolating Oral Exposure to Inhalation Exposure Using the Route to Route Extrapolation Workflow.”
4) Select “Route to Route Extrapolation” as the “Simulation Type.”
5) Under the “Parameters” tab, make sure the appropriate “Exposure” as IRIS Oral RfD, “Parent Chemical” as TCE Chemical Parameters, “Physiology” as Adult Human Male, and “ADME” as ADME for TCE with Oral Exposure tabs are selected. If our project contained multiple sets, we could select the set of our choosing from the drop-down menu.
6) Under the “Variability” tab, make sure that “Physiological Variability” is selected. Since we have not defined variability for other sets, we will leave them at “No Variability Set Found”. Since we will be estimating exposure, we cannot include exposure related variability in this workflow
7) The “Workflow Specific Inputs” tab allows users to define inputs and select data sets specific for the given simulation type. For route to route extrapolation, we need to select the starting exposure route, and estimate for the range of exposures and the number of exposures to run within that range for the Discretized Bayesian Approach (DBA) algorithm.
8) For this study we will set the “Exposure range” from 0.001 ppm to 0.05 ppm. We will discuss the reasons behind selection of this range at the end of this guide.
9) [image: ]Select the number of doses to simulate within this range. Usually this number should be at least 20. We will select 40 for this simulation.
10) Under the “Simulation” tab, set the “Simulation Start Time” to 0, “Simulation Duration” to 1 and duration units to Days from the “Duration Units” drop-down menu. Effectively we will be running a 24h simulation starting at 0. The default number of Monte Carlo runs is set to 1000.
11) Click the “Create Simulation” button to save the simulation.
Running Route-to-Route Extrapolation.
[image: ]The simulation we created will be selected by default in the drop-down menu. If you create other simulations, they can be selected from the drop-down menu. To run the route-to-route extrapolation, select the “Route-to-Route Extrapolation for TCE” and click “Run.” 
[image: ]PLETHEM will first simulate the model with oral exposure to generate a reference plasma concentration. Then PLETHEM will run the Monte Carlo simulations needed to run the DBA algorithm for estimating inhalation exposure. In this case we will run 40,000 simulations to get the necessary plasma concentrations to estimate exposure. This process can take a long time. The progress bar will update users on the number of exposures the model has run. After the calculations are complete, PLETHEM will navigate to the Model output tab to display the results.
Route-to-Route extrapolation results
After the simulation is complete, PLETHEM runs the reverse dosimetry algorithm on the back end and creates a Cumulative Distribution Function (CDF) plot and a Probability Distribution Function (PDF) plot for the expected exposure. If the dose ranges used are adequate, the graphs both the upper and lower tails of the distributions as in the figure below. 
[image: ]
The percentile values for the expected exposure are displayed on the Exposure Estimates tab. Using the model we parameterized, we expect the extrapolated median inhalation exposure for the population to be 0.0145ppm. 
Save the project and quit the user interface 
To save the project at the location first selected for the new project, click the “Save” button from the file menu.
To quit the app, click the “Quit” button from the file menu.
Iteratively approaching the correct dose range
The dose ranges and number of doses selected are driven by a general understanding of the model and scale of biomonitoring results. The DBA is an iterative algorithm for reverse dosimetry. It is very likely that in the initial range selected, either the range is too wide or the extremes are too high or too low to estimate an exposure. The CDF and PDF graphs from the outputs are useful in refining this initial dosage range. If the CDF has a long tail on one end and does not plateau on the other end, that indicates the expected exposure is outside the range currently selected. If the CDF has a long tail at the lower exposure, that means the expected exposure is higher than current dose range; the reverse is true if the tail is at the higher exposures. For this case study, we started with a dose range of 0.001 ppm to 0.05 ppm and then progressively reduced the range unti the CDF included both the lower and upper tails of the distribution.
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